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1. Getting started

In a few steps you'll be producing on the worlds most portable all-in-one HD
multi camera production switcher. Combine 5 HD sources, 2 media players
and 2 graphic overlays into a broadcast quality production, whether for large
format screens or streamed to your audience online using the built-in encoder.
All this, packed into an ultra-portable rugged form factor and seamlessly
integrated with Livestream.com.

The Livestream Studio HD500 is an all in one live production switcher. Its
compact size makes it perfect for anyone needing a portable switcher with
professional capabilities. With your Livestream Studio HD500, you'll be able to:

. Mix up to 5 simultaneous video inputs with 2 channels of internal Media
Player, and 2 channels of GFX overlays.

. Stream HD video to the Livestream platform via the Livestream Studio’s
built in encoder.

. Output a broadcast quality PGM line cut on a variety of digital and
analog connectors.

In the box you'll find:

=

) Livestream Studio HD500 with Windows 7 installed
(1) Blackmagic breakout cable

(1) Carrying Case

(1) Mouse and Keyboard

(1) IEC Power Cable

(1) Livestream Studio USB dongle (shown below)
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Before getting started, you'll want to make sure you have enough space for
your entire setup, cameras, monitors, etc.

0 Remove screws and cover to reveal monitor.
e Attach USB dongle.

Note: The Livestream Studio software WILL NOT RUN without the USB dongle
attached. Always keep the dongle attached to any one of the Livestream
Studio’s USB connectors. The software will prompt you if a dongle is not
detected.

9 Plug-in power cable and switch on the power.

o Press the power button.

Once the Livestream Studio HD500 is up and running, the Livestream Studio
software will launch automatically.

Wlivestream



2. User Interface Overview

The Livestream Studio software will launch to the main operating Ul.

Stream Button
Streaming info Pane
Record Button

CPU Usage Monitor
Preview Window
Program Window
Main Mix Window
GFX Overlay Window
Multiview

Audio Mixer

060000000000

Modules (Input Settings, Streaming, Media Editor, Graphics)

Note: Audio mixer, Input Settings, GFX, Media, and Streaming modules can be
moved freely between left and right side windows by dragging and dropping
tabs to the desired window.
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3. Physical Connections

The Livestream Studio HD500 has multiple digital and analog inputs via the
BlackMagic Decklink Studio Card and the BlackMagic Decklink Quad Card.

BlackMagic Design® DeckLink Studio Breakout Cable

Standard
. Definition
— Analog Audio —— SDI OUT
AES / EBU
R-Y OUT OUT CH 162 ouT1 IN1 IN3 ouT3 Composite S-Video
RS-422 Deck A ;oouT2 : N2 i IN4 : OUT4 out out
Control B-Y OUT R-YIN B-YIN i AES/EBU i i FE HE i i Composite! S-Video }
H H : : : : : : : IN IN

YOUT : ReflN : YIN 'thuszg

BlackMagic Design®
DeckLink Quad

BlackMagic Design®
DeckLink Studio

cAMa cAM3 cAM2 cAM1
W oour ™ our W our

Decklink Studio Breakout Cable

| ®

NVIDIA® GeForce GT 520

HDMI OUT HDMI IN

| c=>e o> 4

Audio I/O

VGA OUT HDMI OUT __DVI/I OUT (DISPLAY)

‘ @@ = ©© 3 ‘ SATA

Headphone Audio Out

' O 2xUsB3.0

M']E[ i Ethernet

2x USB 2.0

4x USB 2.0

Optical S/PDIF

PS / 2 Mouse and
Keyboard

@.-....."..'.....®

2x USB 2.0
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4. Preferences

Before you begin using the Livestream Studio, you will need to configure
your project settings. To begin configuration, click the gear icon in the top
righthand corner of the Ul.

Note: Preferences are locked when streaming is in progress. Be sure to set all
of your preferences before taking a stream live.

4.1 General Preferences

Preferences

General

720p 59.94fps
Input / Output

48kHz Stereo
Hotkeys

Recording 48kHz Stereo

Streaming

About
Pause Playback

Continue Playback

vith Windows (V]

Video Format: Defines the project format for Livestream Studio operation. All
video input sources must match this selected format. Output format will also
match this selection unless downconversion is necessary.

Audio Format: Allows selection of mono or stereo audio operation.

Preview Method: Allows selection of multiview interlaced field viewing. This
selection is unavailable when a progressive video format is selected.

Audio Cross fade duration: Sets the speed (in frames) for audio cross fades
following CUT functionality only. Audio cross fades associated with video
cross fades (follow) will follow the ‘Speed’ setting in the ‘Main Mix" window (see
‘Preview/Program Switching’ section below).
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Media Autoplay Mode Behavior: Defines the method for Media Player
playback as ‘Pause Playback’ or ‘Continue Playback'.

Auto Start with Windows: When selected, Livestream Studio software will
launch with Windows.

4.2 Input/Output Preferences

The Livestream Studio will launch with default settings for (4) HD-SDI inputs
(via Decklink Quad card) and (1) HD-SDI output (via Decklink Studio card). This
configuration can be changed to allow for (5) simultaneous inputs with no live
output (streaming or internal recording assumed in this configuration).

Preferences

General .
Input

Input / Output

Camera Video Input Audio Input
Hotkeys

Cam 1 decklink SDI Studio [1]
Recording
Cam 2 Yecklink SDI Studio [1]
Streaming
Cam 3 Decklink SDI Studio [1]
About
)l Studio [1]

Decklink Studio SDI + Analog

Output Selection: You'll
want to select your output
source first, as this will
lock/unlock the fifth

video input accordingly.
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Input Selection: Once
your output source is set,
you will want to make
sure the proper input

CAM 1

sources are selected.

CAM 2
Select the desired source cAM 3
from the "Video input’

dropdown for each &nla

associated input channel. IS JeckLi d[1] Embedded

Then select the desired
audio input method from the ‘Audio input’ dropdown for each associated
input channel (Decklink Quad inputs will only support SDI embedded audio.
Decklink Studio inputs will support embedded, analog or AES/EBU Audio via
the Blackmagic breakout cable).

Note: Blackmagic analog audio input MUST be accompanied by a video
input source to be active. When using analog audio input, be sure to use the
Decklink Studio card as one of your video inputs.

You can also rename each input channel as it will appear in your multiview by
changing the associated name under the ‘Camera’ column of the input
selection menu.

4.3 Hotkey Preferences

Allows you to set user defined hotkeys for Livestream Studio operation.

Preferences

General

Input / Output

Hotkeys Cam 1 to

Recording

Streaming

About
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4.4 Recording Preferences

Preferences

General

Input / Output

Hotkeys Queue Limit
Recording

Streaming

About

Record Location: Selects the location where Livestream Studio recordings will
be saved. Click the ‘Browse’ button to select your recording location.

Queue Limit: Defines the frame buffer queue limit (in frames) for recording.
Once the queue limit is reached, recording will be terminated.

4.5 Streaming Preferences

Preferences

General

Input / Output
Antilag Dura 5000
Hotkeys Antilag Duration )00

Recording

Streaming e Stop streaming when encoder queue is

About 90 frames

Antilag: When enabled, the antilag feature will work to reduce latency on the
viewing end of the stream:; if delay on the encoding side builds up past the
user selected ‘Antilag Duration’, the frame buffer will be cleared. In general,
this option should remain off unless low latency is a critical component of the
broadcast. It should only be used when a solid internet connection is available
for streaming.

Antilag Duration: Defines the antilag duration (in frames) for use with the
antilag streaming feature (see above).

Key Frame Interval: Set the keyframe interval.

Stop streaming when encoder queue size is: The Livestream Studio will
terminate streaming if the queue limit (set in frames) is reached.

Bitrate (Varialbe vs Constant): Variable bitrate selection will optimize the
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encoder’s bitrate when possible. Constant bitrate selection will maintain
outgoing bitrate, regardless of incoming video bitrate.

5. The Audio Mixer

The Livestream Studio accepts up to 8ch of embedded audio on all digital (SDI
and HDMI) inputs. When the Decklink Studio card is configured as an input, the
or audio mixer or select the desired source from the Input Settings dropdown
menu. can also ingest up to 4ch of analog audio via 1/4", or 6¢ch AES/EBU
audio (analog inputs 3-6 can be used as additional AES inputs when analog
audio is not in use) via the Blackmagic breakout cable.

Audio mixer control is broken down into two modules: ‘Input Settings’ and
‘Audio Mixer’.

5.1 Input Settings

The input settings module allows you to select 2 audio channels per input
source in stereo mode, or a single audio channel per input in mono mode, for
use in the master audio mix. By default, channels 1&2 are selected for all input
sources in stereo mode. Channel 1 is selected for all input sources in mono
mode.

Stream

INPUT 1 INPUT 2 INPUT 3 INPUT 4 INPUT 5 INPUT 6 INPUT 7 INPUT 8 INPUT 9

To open the input settings module for a given source, click the gear wheel
next to the source’s display name in the multiview or audio mixer or select the
desired source from the Input Settings dropdown menu.

Available audio channels will be displayed for the selected source. Use the 'L’
and 'R’ buttons along the bottom of the module to assign left and right audio
channels to the input source fader. Each input channel has an individual level
meter with gain control.
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5.2 Audio Mixer

Once audio channels have been configured for all input sources, the audio
mixer can be used to optimize the mix for webcast, recording, or output.

Audio Mixer

CAM 1 % % £ - MEDIA 1

FOLLOW.

Level Meters and faders: Each input source has a level meter with fader and
gain stage control.

Peak Hold: To enable peak hold for a particular level meter, click the lock icon
associated with the desired input or master output source.

Air: Pushes the selected input source audio to the master fader.

Follow: Audio transitions will follow video transitions. When selected, the
Livestream Studio will fade between sources based on the ‘Audio cross fade
duration’ setting in ‘General Preferences’.

FOLLOW FOLLOW @

Link (input source fader): Works in conjunction with the ‘follow’ setting to
group multiple video inputs to a single audio input. Click the link icon to select
the audio source you would like to use with each video source.

Link (stream out/record out fader): When selected, streaming and recording
audio will follow the same fader. Deselecting this option gives the user control
over stream out and record out audio faders individually.

Mute: Source faders, as well as master stream and record out faders can be
muted individually via the mute button.

Audio Monitoring: Audio monitoring is supported through the Livestream
Studio’s 1/8" headphone jack. Individual sources can be solo’d or master audio
can be monitored. To add a source to the audio monitor, click the headphone
icon below the desired audio level meter. Master audio monitor levels can be
adjusted via the volume control in the top right hand corner of the Ul
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Note: When connecting headphones to the Livestream Studio, Windows will
prompt you to select an audio output device. Select ‘'Headphones’ and close
the dialogue. Then reboot the Livestream Studio software.

Sound Effects

Environment

6. Preview/Program Switching

The Livestream Studio is designed for traditional preview/program switching,
with control available via mouse or user defined keyboard shortcuts. When

a source is selected for preview, it is highlighted in green. When a source is
selected for program, it is highlighted in red.

6.1 Mouse Control

To preview a source, left click on it. To take a MAIN MIX
source to program, right click on it. The
mouse can also control switching via the
‘Main Mix" window. Click the ‘Cut’ button to
cut between preview and program sources.
Click the 'Fade’ button to fade between
preview and program sources; fade time is GFX OVERLAY
defined by the 'Speed’ (in frames) setting in
the Main Mix window. The T-bar can also be
used to manually fade between preview and
program sources.
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6.2 Keyboard Control

Keyboard controls are defined by user selected hotkeys (see ‘Hotkey
Preferences’ above).

7. Streaming

The Livestream Studio comes with Livestream’s proprietary encoder built
in, allowing for multibitrate streaming to the New Livestream platform with
the click of a mouse. Before starting a stream, you will need to setup a New
Livestream account and create an event associated with the stream.

7.1. Livestream Account Creation

The easiest way to stream to the web is via the

Nlivestream
Livestream Platform. In order to stream through Livestream you
must first make an account. Go to www.livestream.com. Click ¢ Fadebook
log in located in the top right corner, and choose create an o
account. Passuor

You can either join via your Facebook account or with an email

address.
Once you have an account you can create events and broadcast
live.

7.2. Creating and Managing Events

To create an event, click on your account name in the top right corner of the
plan and select "Create an Event” from the drop down menu.

You will be prompted to set the event title (by default the current date) as
well as a start and end time for the event.

Create Event - When is it? Posterize

Add a poster to help promote your
event.

Let your followers know when to
Create an event to post text, photos, tune in.

video and live video.
Start Time Al tmes in EDT

Enter a name for your Event 09/18/2012

End Time Artmes in 0T

08N82012 4 [2)[10]%)(Pu[+

Draft Events - By default new event will be in draft mode until you Publish &
Announce them. Draft events are not displayed publicly on your account page,
but you can broadcast to them to test and view them when logged into your
New Livestream Producer Account.
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7.3. Log into Livestream

Click on the ‘Stream’ tab to launch the streaming control module. Enter your
username and password to login.

Stream

Remember me

You can create an event within the streaming module or via a web browser.
Once the event has been created, select it from the event dropdown menu.
Give the stream a title and select your streaming quality from the ‘Quality’
dropdown menu.

7.4 Quality Selection

Each quality setting has a locked audio and video bitrate

associated with it. Quality selection should be based on available upload
bandwidth for streaming. To check the speed of your connection, go to
speedtest.net and run a speed test. Choose the appropriate streaming profile
based on upload bandwidth results.

Stream

(1] Micah Sivitz

":4 Euro Trip 2012 PURIEH

STREAM

Notify my followers when I go live

Mobile Quality:
. Video Bitrate = 130-170Kbps, Audio Bitrate=46-48Kbps
. Total A/V Bitrate = 190-200Kbps

. Recommended Upload Bandwidth = 0.5Mbps
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Normal Quality:
. Video Bitrate = 300-420Kbps, Audio Bitrate=94-96Kbps
o Total A/V Bitrate = 435-455Kbps

. Recommended Upload Bandwidth = 1.0Mbps
Medium Quality:

. Video Bitrate = 470-620Kbps, Audio Bitrate=127-128Kbps
o Total A/V Bitrate = 650-678Kbps

. Recommended Upload Bandwidth = 1.2Mbps
High Quality:

. Video Bitrate = 1400-1600Kbps, Audio Bitrate=256Kbps
e Total A/V Bitrate = 1750Kbps

. Recommended Upload Bandwidth = 2.2Mbps
Medium + Mobile Quality:

. Video Bitrate = 600-800, Audio Bitrate=176Kbps
. Total A/V Bitrate = 850-880Kbps

. Recommended Upload Bandwidth = 1.3Mbps
High + Medium + Mobile Quality:

. Video Bitrate = 1900-2400Kbps, Audio Bitrate=432Kbps
o Total A/V Bitrate = 2570-2610Kbps

. Recommended Upload Bandwidth = 3.0Mbps
HD + Medium + Mobile Quality:

. Video Bitrate = 2500-2900Kbps, Audio Bitrate=430-448Kbps
e Total A/V Bitrate = 3050-3100Kbps

. Recommended Upload Bandwidth = 3.5Mbps
Once quality selection is complete, click the ‘Stream’ button to begin the
stream.

7.5. Active Stream

When streaming is active, the stream info window and Streaming Log provide
live updates on streaming status.
Streaming Info Window: Displays live streaming status info.

® STREAM 00:00:01:01 29.97 FPS 700 Kbps 23 Perfect Streaming

Duration: Displays the current streaming duration.
FPS: Displays the current outgoing fps.
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KBPS: Displays the current outgoing Kbps.
Viewers: Displays the number of concurrent viewers connected to the stream.
Stream Status: Displays the current status of the stream.

Perfect Streaming: The stream is going out with no issues.

Internet Too Slow for Quality: Upload
bandwidth does not support selected quality.

STREAMING LOG
This is generally an on site IT issue and should

o

be escalated to the IT department. Changing
quality requires the stream to be stopped and
restarted.

Lost Internet Connection: Internet connection [
has been lost. Again, check with onsite IT if this
happens.

CPU Warning: CPU is above 95%.

Streaming Log: Displays live streaming updates.
Antilag Feature Triggered: Antilag has been
triggered based on user selected queue limit
(see 'Streaming preferences above).

Press the ‘Stream’ button again to end the stream. When a stream is
terminated, you will be prompted to post the clip live to the event feed, save
the clip as a draft on the event page or delete the server recording.

8. Recording

The Livestream Studio records local files as Motion JPEG .avi at the selected
project format spec. Recordings are saved in a user selected destination
folder (see 'Recording Preferences’ above). Click the ‘Record’ button to begin
recording. Click again to end the recording.

Clips recorded locally on the Livestream Studio are available for immediate
use in Media Players once recording is terminated. Additionally, clips recorded
locally on the Livestream Studio are available for immediate use with
Blackmagic media express, as well as editing software (Adobe Premiere, Fcp,
etc.) with the Blackmagic codec pack installed.

Recording Media: Available recording time is

dictated by available internal disk space. If
necessary, an optional SSD expansion bay

is available. Visit Store.Livestream.com for more info. Additionally, external

devices with transfer speeds of at least 50MB/sec may be used for recording,
though performance may vary with external devices.
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Note: When multiple read/write processes are in play (Media, GFX, recording),
it is recommended that multiple media sources/destinations be used.

9. GFX Channels

The Livestream Studio has two built in GFX overlay channels. When both GFX
channels are active, GFX 2 is overlaid on top of GFX1. Click the 'GFX 1" or ‘GFX
2' tab to access the corresponding GFX module.

9.1 GFX Templates

To add a template, click the + button at the bottom left of the GFX module.
Templates will always be added to both GFX modules. To rename a template,
double click on the display name.

Template Design: Launches template design layout
preview window.

Template Data: Launches dynamic text data

window.

Template Background Selection: While working on a template
design, you can choose the background to work against. Alpha
transparency will be maintained regardless of background
selection.

Importing Assets: Once a template has been created, you can

add components to it via the text or asset addition buttons.

Text: Text can be added to a template in
one of two styles: static or dynamic. Once
text has been added, click the arrow in the

top right hand corner of the asset within the
template to adjust font sytle, size, and color. 1
Static Text: Single line of text that never
changes.

Dynamic Text: Single line of text that can be altered live without changing

templates. To edit a dynamic text asset once it has been added:
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1. Switch to template ‘data’ view.

oestan [BATA

2. Click the '+" button at the bottom of the template to add a dynamic text
line. Rename each line by double clicking on the existing name

3. To preview a template with dynamic text, click the ‘eye’ icon associated
with the desired text line. Click the ‘Air’ button to take it to the template to
PGM. Taking a different text line to air will cross fade between the two
lines of text.

Image Assets: Locally hosted

PNG (with alpha support) or JPEG
image assets can be added to a
template via the Asset Addition button
below the template preview. Once
added, images can be scaled and

,5

positioned with the mouse. Image =1

.

opacity can also be adjusted by
clicking on the arrow in the top right hand corner of the asset within the
template.

Note: When multiple read/write processes are in play (Media, GFX, recording),
it is recommended that multiple media sources/destinations be used.

GFX Template Layering: A single GFX template can
support an infinite number of text or image layers. As
assets are imported, they are added to the top layer
of the template. Right click on the desired image to

move it to another layering position.
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9.2 GFX Mixing and Overlays

GFX mixing is controlled by the ‘GFX
Overlay’ window.

GFX Preview: To preview a GFX
channel, click the eye icon for the
associated channel.

GFX Air: To air a GFX channel, click the
‘Air’ button for the associated channel.
Link GFX Channels: When selected,
both GFX channels will preview or air

together.
Cut/Fade Selection: Assigns cut or fade insert method to GFX channels. Fade
time is defined by the ‘Speed’ (in frames) setting in the Main Mix window.

10. Media Player Channels

The Livestream Studio has two built in Media Player channels. Click the ‘Media
1" or ‘Media 2’ tab to access the corresponding Media Player module.

Media Editor

Pre Show Sting.mov
" 002015112

", Live Show Recording.avi
' 002011512

Recording August 14 2012....
' 002011512

Pre-Show Recording August...
' 00:20:15,12

Pre-Show Recording August...
' 00:20:15,12

00:00:30;,26

Autoplay I8 00:00:15;12

Importing Clips: To add a clip to the selected Media Player channel, click the +
button at the bottom left of the Media Player module and select the locally
hosted file. You can add as many clips to a Media Player playlist as you want.
Once added, you can rename clips by double clicking on their displayed name
within the playlist.

Note: When multiple read/write processes are in play (Media, GFX, recording),
it is recommended that multiple media sources/destinations be used.

Removing Clips: To remove a clip from the Media Player playlist, click the X’
next to the clip name.
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Clip Playback Control: To control playback on a clip, use the playback tools at

the bottom of the clip preview window.

Setting Clip In and Out Points: To set an in or out point on an imported clip,
navigate to the desired timecode and click the In or Out point set button.

) 00:00:30;26

Autoplay: When selected, clips will automatically

play when a transition to the associated Media
Player channel is triggered. Autoplay behavior is

defined by the 'Media Autoplay Mode Behavior’ setting in general preferences.
(see ‘General Preferences’ above). When a clip is 20 seconds or less from its
endpoint, the Media Player preview window will highlight yellow. When a clip
is 10 seconds or less from its endpoint, the Media Player preview window will
highlight red.

Playlist Mode: When selected, the associated media bin will act as a playlist.
Loop Play: When selected, clips or playlists will loop play until the option is
deselected.

Accepted File Types: For compatibility with the Livestream Studio, clips must
be Motion JPEG .avi files (same as Livestream Studio recording codec) in the
selected project format. If necessary, clips can be transcoded to proper spec
via Adobe After Effects.

Clips recorded locally on the Livestream Studio are available for immediate use
in Media Players once recording is terminated.

11. Importing video clips into Media Player

In order for video clips to work in Livestream Studio, they must be AVI files with
MJPEG Video Codec and uncompressed PCM audio (48Khz).

The video clip resolution and frame rate must match the Livestream Studio’s
user selected Video Format (Preferences >> General Preferences >> Video
Format).

In a future update we will provide a video clip converter built into the Studio

software, but for now here is the recommended process for converting video
files from external sources using Adobe Premiere Pro CS6.
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Please note that while we have not tested it, this process should also work with
Final Cut Pro on OSX (assuming you also installed the BlackMagic codec and
drivers).

11.1 Installing Adobe Premiere Pro

You can choose to install Adobe Premiere Pro on either the Livestream Studio
HD500 or another computer. Depending on your need, you can either use
the Premiere Pro 30-day trial (functions without restrictions or watermarks),
buy a license for $799, or get a subscription license via Adobe Creative Cloud
for $75/month or $49/month annually. http://www.adobe.com/products/
creativecloud/buying-guide.html

. Downloading and installing Adobe Premiere Pro CS6
1. Download Installer http://www.adobe.com/cfusion/tdrc/index.
cfm?product=premiere_pro
2. Sign in with a your Adobe ID. If you do not have one, registration is
free.

. Once the download is complete, the installer should automatically
launch. Follow the steps to complete installation.

. Once Adobe Premiere Pro is installed you will have to install the latest
version of the Blackmagic Design Driver.

Note: if you already have the most updated version of Blackmagic design
driver you will have to remove it and reinstall the driver.

11.2 Downloading and Installing the Blackmagic Design
Driver

Note: Please ensure that Adobe Premiere is installed before performing this
step.

. Go to: http://www.blackmagicdesign.com/support/
detail?sid=3945&pid=4012&leg=falseGos=win

. Download Desktop Video

. If you have Desktop Video already on your computer, you will have to
remove it, then reinstall the driver. If you do not have Desktop video skip
to Step 3

. Open the Desktop Video file downloaded
1. Once open, select remove all files
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2.
3.

Change, repair, or remove installation

.. D
Select the operation you wish to perform. Blackmaglcd&ﬂgng

Change

Blackmagic Design Desktop Video has no independently selectable features.

Repair
Blackmagic Design Desktop Video cannot be repaired.

Remove

Removes Blackmagic Design Desktop Video from your computer.

Select remove, then follow the steps to complete the uninstall
Restart the computer

Installing DesktopVideo

1.
2.

3.
4.

Open the saved Desktop Video file
Follow the steps to complete installation
Note: Windows Security might prompt you to verify the publisher:

Windows can't verify the publisher of this driver software

< Don't install this driver software

You should check your manufacturer's website for updated driver software
for your device.

< Install this driver software anyway

Only install driver software obtained from your manufacturer's website or
disc. Unsigned software from other sources may harm your computer or steal
information.

i:\-f:] See details

Select “Install this driver software anyway”.
When the driver completes installation, restart the computer
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11.3 Converting Video Files using Adobe Premiere Pro

. Open Adobe Premiere Pro and Choose a new project:

Recent Projects

New Project Open Project Help

. Select your capture format:

Video Rendering and Playback

Display Format:

Audio

Display Format:

Capture
Capture Format: tu Properties...
DV
HDV

Blackmagic Capture

Location:

Nam

. Select your sequence settings.
Important: These should match the Video Format setting of your Livestream
Studio Project.
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Here are two examples:

Available Presets Preset Description
> W ARRI
» B AVC-Intra
» @ AVCHD
v @ Blackmagic Design

M 10 bit RGE
M 10 bit YUV
i 3 bit YUV
M Motion-IPEG
v B Interlaced

Available Presets Preset Description
» [ ARRI
» [ AVC-Intra
» [ avcHD
v W Blackmagic Design

» & 10 bit YUV
» i 5 bit YUV
v [ Motion-JPEG

»
@ Canon XF MPEG2
@ Digital SLR

B DV - 24P

@ Mobile & Devices

Sequence Name

Import your video clip.
1 Go to: File>Import

25



2. Select your video file and select open

The imported file should appear in your clip bin:

0:00  42-tir1_h720p.mov

. Drag your clip into the timeline.
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1. You will be prompted to either Change or Keep Sequence Settings
Choose "Keep Sequence Settings”

Clip Mismatch Wa

Exporting video clip.
1. Go to File>Export>Media

File] Edit Project Clip Sequence Marker Title Window Help

New »
Open Project. Cirl-0.
Open Recent Project »
Browse in Adobe Bridge. Ctil+Alt+0

Close Project Ctrl+Shift-W
Close Cerew
Save Ctrs
Save . Ctrls Shift+S

Savea Copy. Ctl+Alt+S
Revert

Capture
Batch Capture.

Adobe Dynamic Link
Adobe Story

Send to Adobe SpeedGrade...
Import from Media Browser Ctri+Alts1
Import. Ctrl+1
Import Recent File
Export Ctrk+M
Get Properties for
Revealin Adobe Biidge.

Eit Cul+Q

Final Cut Pro XML,
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Select "Match Sequence Settings”

Source Scaling: | Scale To Fit
Format:
Preset:
Comments:

Output Name:

v Summary

Output: C:\User...ents\AdobelPremiere Pro\6.0\Sequence 01.avi
12806720 1.0000 Frogressive

48000.000000 Hz

Source: Sequence, Sequence 01
1280x720 (1.0), 59.94 fps, Progressive, 00:01:46:35
48000 Hz, Stereo

video

¥ Video codec

Codec:

¥ Video settings
Width
Use Maximum Render Quality ™ Use Previews
00:01:46:35 Use Frame Blending

Source Range: | Work Area Metadata...

Output

¥ Export Settings
Source Scaling: | Scale To Fit
¥/ Match Sequence Settings
Format:

Preset:

Comments:

v Summary
Output: C:\User...ents\Adobe\Premiere Pro\6.0\Sequence 01.avi
1280%720 1.0000 Progressive

48000.000000 Hz

Source: Sequence, Sequence 01
1280x720 (1.0), 59.94 fps, Progressive, 00:01,
48000 Hz, Stereo
deo
¥ Video codec

Codec:

¥ Video settings
Width:
Use Maximum Render Quality ~ Use Previews
00:01:46:35 Use Frame Blending

Source Range: | Work Area Metadata.. Queue Cancel

Use Maximum Render Quality | Use Preview

00:01:46:35 Use Frame Blending

Source Range: Work Area Metadata...
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. Once exporting you should see this window:

E-m:udin '

Estimated Time Remaining: 00:00:24

See section 10 about adding clips to the media player.

12. Tech Specs

Live Video Input

. 5 simultaneous HD/SD SDI live video sources when configured for
streaming or recording (no live video output)

. Or 4 simultaneous HD/SD SDI live video sources when live video out is
enabled

Media Sources

. 4 integrated digital media sources for video & graphics playback
. 2 Media Players (video clip playback)
e 2 GFX (graphics)

Live Video Output

. 5 live outputs

. 1 x HD/SD SDI (Program)
. 1x HDMI (Program)

. 1 x Composite (Program)
. 1 x Component (Program)
. 1 x S-Video (Program)

Built-in Multiview

. On-screen full field rate multiview of all live inputs, Preview, Program Out,
2 GFX and 2 Media Player
. Audio PPM overlay with peak hold feature on all inputs and outputs
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Resizable layout allowing hiding of all controls to maximize multiview
screens
Latency from SDI input to multiview : 5 Frames

Video Switcher/Mixer

1 x Mixer & Effects Bank (M/E) with no upstream keyer

Transitions

Fade (Auto transition with adjustable duration in frames, manual via on-
screen T-BAR or keyboard shortcuts)

Cut

SMPTE Wipes**

Graphics Downstream Key

2 x Graphics DSK (downstream key) channels, one channel for GFX1 and
one channel for GFX2

Independent or locked transition controls (fade/cut), positioning**,
scaling**, cropping**

Preview on multiview

Graphics & Titling (GFX 1 & 2)

Load JPG or PNG files (full transparency support with PNG files)
Add text (set position/font/size/color) over any loaded image file within
the GFX1 or GFX2

Video Clip Playback (Media Player 1 & 2)

2 x Media Player sources with :

Eject/Load clip

Play

Pause/stop

Audio/Video Scrubber

Timecode indicator

Seek to timecode

Mark In/Mark Out (set and type in option)
Loop

Auto-play on transition

Recording

AVI MJPEG with uncompressed audio
Configurable bitrate
Interlacing and timecode support
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Recording Capacity

~10 hours at 1080i (Using 500Gb built in Hard Drive with recorder set to
record at 100Mbps MJIPEG AVI).

Live Streaming

HD live streaming via Gigabit/100/10 built-in Ethernet

Presets in up to HD 720p

Multiple Adaptive Bit-Rates including mobile quality for playback over 3G
on mobile devices (iPhone/Android)

Simultaneous MP4/AAC file archive of all bitrates renditions

Audio Inputs

Up to 5 stereo inputs from SDI Embedded inputs with user selectable left/
right channel from any of the 8 SDI embedded audio channels

4 Channels of professional balanced analog audio via 1/4" jack
connectors

Audio Outputs

Stereo out from mixer embedded in the SDI output
1 Stereo 1/8" for live headphone monitoring (Ability to select master
output mix or individual inputs)

Audio Mixing

Integrated multi-channel audio mixer for internal and external audio
sources, outputs, stream and headphones

Incorporated video switcher follow feature with audio crossfade support
when fading two video source

Supported Formats

HD: 720p50, 720p59.94, 720p60, 1080PsF23.98, 1080p23.98, 1080PsF24,
1080p24, 1080PsF25, 1080p25, 1080PsF29.97, 1080p29.97, 1080PsF30,
1080p30, 1080i50, 1080i59.94 and 1080i60

SD: 625/25 PAL, 525/29.97 NTSC, 525/23.98 NTSC

Playback Media Formats

GFX: JPEG, PNG image files with transparency support
Media Player: AVI MIPEG with uncompressed audio, MP4 (AAC/H264)**
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Record Media Formats

. AVI MJPEG with uncompressed audio

Operating System

. Windows 7 Professional (64 bit)

Built-in Display
. Integrated 17" WUXGA+ (1920X1200) HD Display

CPU

Intel “Sandy Bridge-E" Core i7 3930K 3.2 GHz Six-Core processor, 12MB L3
cache, 130W, Socket LGA 2011

Graphics Card
. Nvidia GeForce GT 520 Commercial Series PCI Express graphics card

RAM

. 8GB4 total Media Player3 1333 MHz RAM (non-ECC) (2GB x 4 DIMM
triple-channel configuration)

Processing

«  Video: 4:2:2, 10 bit Color (REC 601, REC 709)

. Audio: 48 kHz, 24-bit

. REF IN/Genlock (Requires genlocking the two Blackmagic cards via two
separate connectors)

System Physical

. 5.8" (D) x 12.40" (H) x 16.75" (W)
. ~ 15 lbs

Built-in Video Input/Output Cards

. Blackmagic Design DeckLink Quad (PCl)
. Blackmagic Design DeckLink Studio (PCI)
Included in the box

** Feature not yet available but will be made available via free online
software update.
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Warranty

Livestream provides a limited one (1) year warranty for the Studio HD500 and a
thirty (30) day limited warranty for the carrying case and any peripherals.

The limited warranty covers defects in components and workmanship as well
as functionality of the Livestream Studio software. The warranty start date
begins on the day the unit is shipped.

The limited warranty does not cover the following:

. Software, including the operating system and any third party software
. Failure due to viruses, bugs, or any type of malicious software

. Hardware or components not included in the original assembly

. External computer hardware products and peripherals

. Problems that result from:

1. Accident, abuse, or misuse

2. Servicing not authorized by Livestream

3. Usage that is not in accordance with product instructions

4. Failure to follow the product instructions or failure to perform
preventive maintenance

5. Failure to follow Livestream'’s technical support or RMA instructions
including improper packaging

. Product that has been damaged by actions that are beyond Livestream's
control, including for example, impacts, fluids, fire, flood, wind,
earthquake, lightning or similar disaster, war, strike, lockout, epidemic,
destruction of production facilities, riot, insurrection, or material
unavailability

Livestream will replace or repair any component or system free of charge.
Livestream will ship free of charge any item covered by warranty back to
the customer in the continental United States via ground delivery. Any other
shipping fees will be covered by the customer. Customer must insure both
ways if insurance is desired. Livestream does not insure RMA shipments. To
request an RMA, go to help.livestream.com and fill out a support claim.
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